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ABSTRACT 

 

In this paper, an attempt has been made to study the effect of cutting speed and 

feed rate on the cutting forces and chip breakage in turning process. Nowadays 

researches on metal cutting processes are being done in different laboratories as 

it is of importance not only for understanding the fundamentals of metal cutting 

processes but also for the design of different metals used in laboratories both for 

scientific and engineering purpose. Understanding of the fundamentals of metal 

cutting processes through the experimental studies has some limitations. Metal 

cutting modeling provides an alternative way for better understanding of 

machining processes under different cutting conditions. Using the capabilities 

of finite element models, it has recently become possible to deal with 

complicated conditions in metal cutting. Finite element modeling makes it 

possible to model several factors that are present during the chip formation .As 

simulation tool for the purpose of this study; the FEM software used is 

AdvantEdge FEM. AdvantEdge FEM is a CAE (Computer Aided Engineering) 

software solution for the optimization of metal cutting. This modeling software 

is used by those looking to improve tool design, increase material removal 

rates, extend tool life, improve part quality, and much more. We use 

AdvantEdge FEM to decrease the need for trial and error testing. The 

simulation results on cutting forces and chip thicknesses are compared with 

experimental data in order to indicate the consistency and accuracy of the 

results when conducting the comparison. Actually this paper presents the 

advantage of using software for simulation of cutting process and study of 

stainless steel turning. To complete our research wok we use 2D Finite Element 

Model (F.E.M.) of chip formation process, proposed in the software named 

AdvantEdge FEM with an experimental set up in the laboratory. The 

experimental validation showed a good qualitative agreement. Thus, FEM of 

cutting process can be considered as a promising and reliable tool for 

machining development within the near future. 
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Chapter 1  

INTRODUCTION: 

1.1 Overview 

Machining process such as turning, milling, boring and drilling are among 

others the most important process for discrete part manufacturing. Researchers 

have been studying machining processes for more than a century to gain better 

understanding and develop more advanced manufacturing technology. 

The study of turning has lasted more than a century, but it still attracts a large 

amount of research effort. This is because turning is not only most frequently 

used machining operation in the modern manufacturing industry, but also 

because it is typical single-point machining operation. Other machining 

operations, such as milling, drilling and boring are multiple-point machining 

operation that can be investigated based on the combinations of single-point 

machining operation. Thus, the study of turning can contribute greatly to the 

knowledge of metal cutting principles and machining practice. 

The turning process is used widely in industry and has countless applications. 

Traditionally, the process has been used to reduce the diameter of cylindrical 

work piece, or to change a work piece of non-circular cross-section. This is 

done by rotating the work piece about this of the machine’s spindle and 

removing the work piece material with the cutting tool which is fed in the 

perpendicular direction. For the past fifty years metal cutting researchers have 

developed many modeling techniques including analytical techniques, slip-line 

solutions, empirical approaches and finite element techniques. In recent years, 

the finite element analysis has particularly become the main tool for simulating 

metal cutting processes. Finite element analysis are widely used for calculating 

the stress, strain, strain-rate and temperature distributions in the primary, 

secondary and tertiary sub-cutting zones. In consequence, temperatures in the 

tool, chip and workpiece, as well as cutting forces, plastic deformation (shear 

angles and chip thickness), chip formation and possibly its breaking can be 

determined faster than using costly and time consuming experiments. In this 
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work, mechanically based models are developed that are able to predict the 

effect of cutting speed and feed rate on the cutting forces in turning process. 

 

1.2 The Turning Process 

Turning is the process whereby a single point cutting tool is parallel to the 

surface. It can be done manually, in a traditional form of lathe, which frequently 

requires continuous supervision by the operator, or by using a computer 

controlled and automated lathe which does not. This type of machine tool is 

referred to as having computer numerical control, better known as CNC, and is 

commonly used with many other types of machine tool besides the lathe.  

When turning, a piece of material (wood, metal, plastic even stone) is rotated 

and a cutting tool is traversed along two axes of motion to produce precise 

diameters and depths. Turning can be either on the outside of the cylinder or on 

the inside (also known as boring) to produce tubular components to various 

geometries. Although now quite rare, early lathes could even be used to 

produce complex geometric figures, even the platonic solids; although until the 

advent of CNC it had become unusual to use one for this purpose for the last 

three quarters of the twentieth century. It is said that the lathe is the only 

machine tool that can reproduce itself.  

The turning processes are typically carried out on a lathe, considered to be the 

oldest machine tools, and can be of four different types such as straight turning, 

taper turning, profiling g or external grooving. These types of turning processes 

can produce various shapes of materials such as straight, conical, curved, or 

grooved workpiece. In general, turning uses simple single-point cutting tools. 

Each group of workpiece materials has an optimum set of tools angles which 

have been developed through the years. The bits of waste metal from turning 

operations are known as chips. 

In deed Turning is a very important machining process in which a single-point 

cutting tool removes material from the surface of a rotating cylindrical work 

piece. The cutting tool is feed linearly in a direction parallel to the axis of 

rotation. Turning is carried out on a lathe that provides the power to turn the 
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work piece at a given rotational speed and to feed the cutting tool at a specified 

rate and depth of cut. Therefore, three cutting parameters, i.e. cutting speed, 

feed rate, and depth of cut, need to be determined in a turning operation. Two 

basic models are in focus: orthogonal (two force) models, and oblique (three-

force) models. Most machining processes are oblique but the orthogonal model 

studies are easier to simulate and they can be useful: adequate for understanding 

the basic mechanics of machining processes. 

 

1.2.1 Turning operations 

 

Turning specific operations include: 

 

Turning: 

 

This operation is one of the most basic machining processes. That is, the part is 

rotated while a single point cutting tool is moved parallel to the axis of rotation. 

Turning can be done on the external surface of the part as well as internally 

(boring). The starting material is generally a workpiece generated by other 

processes such as casting, forging, extrusion, or drawing. 

 

Tapered turning: 

 

a) from the compound slide b) from taper turning attachment c) using a hydraulic 

copy attachment d) using a C.N.C. lathe e) using a form tool f) by the offsetting of 

the tailstock - this method more suited for shallow tapers. 

 

 

Spherical generation: 

 

The proper expression for making or turning a shape is to generate as in to generate 

a form around a fixed axis of revolution.  

a) Using hydraulic copy attachment  

b) C.N.C. (computerized numerically controlled) lathe  

http://en.wikipedia.org/wiki/Machining
http://en.wikipedia.org/wiki/Casting
http://en.wikipedia.org/wiki/Forging
http://en.wikipedia.org/wiki/Extrusion
http://en.wikipedia.org/wiki/Drawing_%28manufacturing%29
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c) Using a form tool (a rough and ready method)  

d) Using bed jig (need drawing to explain). 

 

 

Hard turning: 

 

Hard turning is a turning done on materials with a Rockwell C hardness greater 

than 45. It is typically performed after the workpiece is heat treated. 

The process is intended to replace or limit traditional grinding operations. Hard 

turning, when applied for purely stock removal purposes, competes favorably with 

rough grinding. However, when it is applied for finishing where form and 

dimension are critical, grinding is superior. Grinding produces higher dimensional 

accuracy of roundness and cylindricity. In addition, polished surface finishes of 

Rz=0.3-0.8z cannot be achieved with hard turning alone. Hard turning is 

appropriate for parts requiring roundness accuracy of 0.5-12 micrometres, and/or 

surface roughness of Rz 0.8–7.0 micrometres. It is used for gears, injection pump 

components, hydraulic components, among other applications. 

 

 

Facing: 

 

Facing in the context of turning work involves moving the cutting tool at right 

angles to the axis of rotation of the rotating workpiece.This can be performed by 

the operation of the cross-slide, if one is fitted, as distinct from the longitudinal 

feed (turning). It is frequently the first operation performed in the production of the 

workpiece, and often the last—hence the phrase "ending up". 

 

 

Parting: 

 

This process, also called parting off or cutoff, is used to create deep grooves 

which will remove a completed or part-complete component from its parent stock. 

Grooving 

Grooving is like parting, except that grooves are cut to a specific depth instead of 

severing a completed/part-complete component from the stock. Grooving can be 

performed on internal and external surfaces, as well as on the face of the part (face 

grooving or trepanning). 

 

 

 

http://en.wikipedia.org/wiki/Rockwell_scale
http://en.wikipedia.org/wiki/Heat_treatment
http://en.wikipedia.org/wiki/Grinding_%28abrasive_cutting%29
http://en.wikipedia.org/wiki/Facing_%28machining%29
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Non-specific operations include: 

 

Boring: 

 

Enlarging or smoothing an existing hole created by drilling, mouldingetc.i.e. the 

machining of internal cylindrical forms (generating) a) by mounting workpiece to 

the spindle via a chuck or faceplate b) by mounting workpiece onto the cross slide 

and placing cutting tool into the chuck. This work is suitable for castings that are to 

awkward to mount in the face plate. On long bed lathes large workpiece can be 

bolted to a fixture on the bed and a shaft passed between two lugs on the 

workpiece and these lugs can be bored out to size. A limited application but one 

that is available to the skilled turner/machinist. 

 

 

Drilling: 

Is used to remove material from the inside of a workpiece. This process utilizes 

standard drill bits held stationary in the tail stock or tool turret of the lathe. 

 

 

Knurling: 

 

KnurlingThe cutting of a serrated pattern onto the surface of a part to use as a hand 

grip using a special purpose knurling tool. 

 

 

Reaming: 

 

The sizing operation that removes a small amount of metal from a hole already 

drilled. 

 

 

Threading: 

 

Both standard and non-standard screw threads can be turned on a lathe using an 

appropriate cutting tool. (Usually having a 60, or 55° nose angle) Either externally, 

or within a bore. Generally referred to as single-point threading. Tapping of 

threaded nuts and holes a) using hand taps and tailstock centre b) using a tapping 

http://en.wikipedia.org/wiki/Boring_%28manufacturing%29
http://en.wikipedia.org/wiki/Drilling
http://en.wikipedia.org/wiki/Drill_bits
http://en.wikipedia.org/wiki/Knurling
http://en.wikipedia.org/wiki/Reaming
http://en.wikipedia.org/wiki/Threading_%28manufacturing%29
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device with a slipping clutch to reduce risk of breakage of the tap. Threading 

operations include a) all types of external and internal thread forms using a single 

point tool also taper threads, double start threads, multi start threads, and worms as 

used in worm wheel reduction boxes, leadscrew with single or multistart threads. 

b) By the use of threading boxes fitted with 4 form tools, up to 2" diameter threads 

but it is possible to find larger boxes than this. 
 

 

 

Figure1.1: Different types of turning operation 
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1.2.2 Turning Parameters 

 

The characteristic parameters of a turning operation are: 

 Cutting Speed 

 Feed rate 

 Depth of Cut 

 Different types of angles such as:  

                           *Rake Angle  

                           *Clearance angle  

                           *Wedge Angle  

 

Cutting Speed: 

 

 The Speed at which the cutting tool passes the work, or vice versa 

 In Turning….   

 Cutting Speed may be thought of as the peripheral speed of the work 

piece with respect to the stationary cutting tool 

 An appropriate Cutting Speed is determined by considering things such as: 

 Material type and condition 

 Cutting tool material 

 Actual machine factors 

 Experience 
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 Cutting Speed Units: 

 Feet per Minute (FPM) or sometimes SFM (Surface-feet per Minute) 

 MPM (Meters per Minute) 

 Cutting Speed is used to calculate spindle rotations per minute (RPM) 

 RPM = (12 * CS) / (3.14 * Dia.) (Note: Inch units) 

 More simply put… RPM = (4 * CS) / Dia. 

 

Feed rate: 

 

 The rate at which a tool travels longitudinally 

 An appropriate feed rate is determined by considering things such as: 

 Surface finish requirements 

 Material type and condition 

 Actual machine factors 

 Experience 

 Feed rate Units for turning:  

 Feed per revolution (IPR – inches per revolution) 

 Sometimes converted to feed per minute (IPM – inches per minute) 

 IPM = IPR * RPM 

 

Depth of Cut: 

 

 The distance the tool is plunged into the material 
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 Units 

 Inches or MM 

 (remember… in turning, the diameter of the work piece will 

change by twice the depth of cut) 

 

 Selection 

 DOC is determined by machine/cutter limitations and experience 

 

Figure1.2: Depth of cut measurement  

 

Different types of angles: 

 

 Rake Angle (γ): This is the angle between the tool face and the plane 

normal to the surface of the cut and pressing through the tool cutting edge. 

 Clearance angle (α): This is also known as relief angle, it is the angle 

between the tool face adjacent to the surface of the cut. This angle helps to 

eliminate rubbing between the tool and the surface being cut and hence 
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reduces friction to the beeriest minimum. According to Charles’ (1971) a 

clearance angle of 60 to 80 is large enough to prevent excessive rubbing of 

the tool on the work piece.  

 Wedge Angle (β): This is the angle formed by the rake and the relief angle, 

which is between the rake face and the relief face or between the tool face 

and the tool relief face.  

                    In general:  α  +  β  +  γ  =  90
0
 

 

Figure1.3: Different types angles in turning  
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1.3 Background of the project 

 

This research work is executed to compare the orthogonal cutting data from 

AdvantEdge FEMsoftware with experiments by creating numerical model to 

simulate the orthogonal metal cutting. 304-stainless-steel is used as the workpiece 

material in this study because it has been the focus of many recent modeling 

studies and well machinability.   

Thus, this software is used to simulate the cutting process from the initial to the 

steady state of cutting force. The orthogonal turning data is verified and a 

comparison is made between experimentally and simulations to investigate the 

effect of cutting speed and feed rate on the cutting forces and chip breakage in 

turning process as a practical tool by researchers, machine and tool makers. This is 

the reason why the application of FEM software to cutting operations is quite 

common nowadays.  

To simulate with the help of AdvantEdge FEM software in a 2D or 3D 

environment makes it possible to see the process more in detail and to make more 

accurate predictions even for processes that are well represented by a plane model 

(such as orthogonal cutting). Moreover, it allows simulating more complex 

operations that need to be studied by a three-dimensional model (such as oblique 

cutting). Actually in this thesis work we doFem based simulation and analysis of 

stainless steel turning with the help of AdvantEdge FEM software in 2D 

environment. 

 

1.4 Problem Statement 

In recent years, the application of finite element method (FEM) in cutting 

operations is one of the effective ways to study the cutting process and chip 

formation. In particular, the simulation results can be used as a practical tool, 

both by researchers and tool makers to design new tools and to optimize the 

cutting process. 
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Facing and turning in metal cutting of turning process, it is very complicated to 

determine the optimization of cutting conditions due to a lot of cutting  

experiments need to be execute. Further, these experimental also consider in 

risks condition because not all the results from the experiments could be achieved 

as desired. For the results which are not fulfill the optimized cutting condition, the 

experiments should be repeated and this will lead to high costing to the industry 

manufacturer worldwide in terms of time demanding, human energy and work 

material respectively. In order to reduce the costs and time, FEM in machining is 

widely used nowadays and has become main tool for simulating metal cutting 

process.  

Based on cutting experiments, the simulation were carried out to verify using FEM 

to indicate that the simulation result are consistent or not with the experiments. 

This study aims to simulate two-dimensional cutting operations and the FEM 

software used for this study is AdvantEdge FEM. 

 

 

1.5 Objective of study 

 

The overall goal of this proposal is to develop methodologies using finite element 

simulations and to differentiate the actual value from the previous experimental 

result with the AdvantEdge FEM 2D simulation result. The data that have been 

taken into computation are cutting force, temperature and time. Thus, the 

objectives are to: 

 Study and determine the influence of process parameters (feed rate, cutting 

speed, and rake angle, depth of cut and length of cut) upon cutting force and 

chip breakage.  

 To compare between simulation and experiment cutting test to indicate the 

results are consistent or inconsistent.  

 Demonstrate the use of AdvantEdge FEM for 2D simulation in turning 

processes.  
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1.6 Scope of Study 

 

(I)  Simulation 2D cutting test is using AdvantEdge FEM software.  

(ii)  Work piece are use is stainless steel of 0.1-0.3% carbon (304-stainless-steel).  

(iii)  Tool material use is carbide-general with rake angle -5
0
. 

(iv) To differentiate between the simulations conducted by using AdvantEdge 

FEM software with the results obtained by the previous researcher as follow: 

 Experiment result; and  

 Results from advantEdge software.  

 

 

1.7 Importance and Significance of Study 

 

The significance of this research work is that Finite Element Analysis (FEA) in 

machining process will be a great help for the researchers to understand the 

mechanics of metal cutting process. Furthermore, the FEA technique has proven to 

be an effective technique for predicting metal flow and selecting optimum working 

conditions such as tool and workpiece temperatures and cutting force.   

In addition, the influence of several parameters such as feed rate, cutting speed, 

and rake angle, depth of cut and length of cut has been studied. This simulation 

will not involve chip elimination before the real material is cutting which indirectly 

lead to time and cost saving. 
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1.8 Expected Result 

 

In this study, the investigation indicates the results from simulation cutting test in 

terms of cutting forces and chip breakage dependent on the cutting parameters such 

as cutting speed, rake angle, depth of cut and length of cut.  

In addition, this research also includes the analysis for the results and graphs from 

simulation machining such as cutting force, torque, power, peak tool temperature, 

stress, and tool deflection versus time, thrust force versus time and contours of 

temperature, heat rate, stress, strain, pressure, and velocity in correlation to tool 

and/or workpiece. Later, make a comparison between the simulation and 

experiment result to predict whether the results are consistent or inconsistent.  
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Chapter 2 

LITERITURE REVIEW: 

 

2.1   Introduction  

 

For years, researchers in the area of metal cutting have attempted to develop model 

of cutting processes that described the mechanisms involved and predict the 

important behaviours in the process without requiring a large amount of cutting 

test. Various models have developed for this purpose. In this chapter, previous 

publication relating to the metal cutting is reviewed. The reviewed topics are 

organized as follows: 

 Fundamental of metal cutting 

 Friction models 

 Cutting force models 

 Finite element models  
 

 

2.2   Fundamental of Metal Cutting 

 

The most widely used metal cutting operation is turning, milling and drilling. 

Turning is a process of using a single point tool that removes unwanted material to 

produce a surface of revolution. Figure 2.1 shows a cylindrical surface being 

generate on a workpiece and the movement of the cutting tool along feed direction 

[Kalpakjian, 2001]. 
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               Figure 2.1: Three dimensional view of turning operation [Kalpakjian, 2001]  

 

The need to understand and model the metal cutting process is driven by a number 

of technological requirements. Basically, the operation should be feasible to 

achieve the required quality of machined part and efficiency. Knowledge of the 

cutting process is also important for improvement of machine tool design. 

Researchers have been conducting experiments and developing models to explain 

the underlying mechanism of the cutting process for more than fifty year. Most of 

the proposed models can be classified as analytical, experimental and numerical as 

listed in table 2.1 
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The importance of machining process modeling has been universally recognized in 

industry. Basic and applied research result has been employed to provide reliable 

predictions of the performance of the cutting process and the impact of the process 

on produce quality and process productivity [Ehmann, 1997].  

In a simple way, most metal cutting operations can be described in terms of a 

wedge-shaped cutting tool that is constrained to move relative to the workpiece in 

such a way that a layer of metal is removed in the form of a chip. When the cutting 

edge of the tool is arranged to be perpendicular to the direction of cutting velocity, 

it is called orthogonal cutting. Oblique cutting involves an inclination angle 

[Boothroyd, 1989].  

 

 

2.2.1 Orthogonal Cutting  

 

 

Orthogonal cutting, as illustrated in Figure 2.2 is the simplest machining process 

and rarely used in industrial practice. The significance of orthogonal cutting is 

serving as an ideally simple cutting process model in theoretical and experimental 

work. It can be modeled as a two dimensional process. In orthogonal cutting, 

effects of independent variables have been eliminated as much as possible so that 

influences of basic parameter can be studied more accurately. Most of the further 
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studies on machining process are based on the achievement from orthogonal 

cutting analysis. The assumptions Shaw [Shaw, 1984] on which orthogonal cutting 

is based to achieve simplicity include as follow:  

 The tool is perfectly sharp and there is no contact along the clearance face. 

 The shear surface is a plane extending upward from the cutting edge.  

 The cutting edge is a straight line extending perpendicular to the direction of 

the cutting velocity and generates a plane-machined surface.  

 The chip does not flow to either side.  

 The depth of cut is constant.  

 The width of cut is constant.  

 The workpiece moves relative to the tool with uniform velocity.  

 A continuous chip is produced with no build-up edge.  

 The shear and normal stresses along shear plane and tool are uniform.  
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2.2.2 Oblique Cutting  

 

 

In practice, most cutting operations involve oblique cutting, where the cutting edge 

is inclined. In the oblique arrangement shown in figure 2.3, the cutting edge 

inclines at an angle. This angle makes the cutting process modelling more 

complicated than that for orthogonal cutting. Three-dimensional analysis needs to 

be performed to study oblique cutting. 
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2.3 Friction model  

 

A general conception of friction can be considered as the tangential force 

generated between two surfaces. Friction can be represented as a resistance force 

acting on the surface to oppose slipping. Figure 2.4 (a) shows a simple example of 

friction where a block is pushed horizontally with mass m over rough horizontal 

surface. As showing in the free body diagram, Figure 2.4 (b), the body has 

distributions of both normal force N and horizontal force f along the contact 

surface. From the equilibrium, the normal force N acts to resist the weight force of 

the mass mg and the friction force f acts to resist the force F.   
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Basically, there are two types of friction, which are static and kinetic as shown in 

Figure 2.5. By increasing the force F, friction force f increases too. The blocks 

cannot move until the force F reaches the maximum value. This is called the 

limiting static factional force. Increasing of the force F further will cause the block 

to begin to move. In the static portion, the limiting friction force can be expressed 

as:  

Fstatic = μs N  

Where μs is called the coefficient of static friction   

 

When the force F becomes greater than Fstatic, the frictional force in the contact 

area drops slightly to a smaller value, which is called kinetic frictional force. 

Machining models generally just consider the kinetic friction coefficient which can 

be calculated by the following equation:  

Fkinetic=  μk N 

Where μk is called the coefficient of kinetic friction 

                      



Page | 30 
 

 

2.3.1  Albrecht's Coulomb friction coefficient  

 

In the the Coulomb friction coefficient, Albrecht's analysis has been used to 

estimate the coefficient of friction along the chip-tool interface by eliminating the 

cutting edge effect [P. Albrecht,1960]. Figure 2.6 illustrates the basic concept of 

Albrecht's model.  

 

                

 

The forces are resolved into two components where P is close to the cutting edge 

and Q is applied on the rake face. With the sharp cutting tool, the ploughing force 

P has insignificant value. But for the tool that is not sharp, the force P will affect 

significantly the force model. For uncut chip thickness greater than the critical 

uncut chip thickness.  

             Albrecht assumes that the force P has a constant value. However, at feeds 

less than the critical uncut chip thickness, the force P will affect the thrust force 
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significantly. After passing the critical chip thickness, the force P slightly affects 

the thrust force. Example feeds and chip thickness are shown in Figure 2.7. The 

sum of the two force components (cutting and feed) can be obtained by the sum of 

two vectors P and Q. 

 

         

 

 

Figure 2.8 illustrates the cutting force and the thrust force relation at different 

uncut chip thicknesses. At the smallest feeds in Figure 2.8 (A and B sections), a 

non-linear relation will describe the behaviour of the cutting and thrust forces. 

Below the critical point, the P force will cause a relatively large thrust force. The 

section C where the relation takes a linear behaviour is used to approximate the 

value of the Coulomb friction coefficient. The friction coefficient along the chip 
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tool interface can be defined by taking the slope of section C as tan (A - a) and 

then μ = tan γ . 

 

 

 

 

2.4 ANALYTICAL FORCE MODEL  

 

 

Since 1930, many researchers have tried to understand the machining process 

under framework plasticity theory. The studies of chip formation were the main 

goal in order to know the cutting force, stresses and temperatures involved in the 

process. Various methods were proposed which are several of the study based on 



Page | 33 
 

fundamentals of mechanical cutting process and others based on experimental. 

Simplified analytical approaches of orthogonal cutting were first considered by 

Merchant [Merchant, 1945], who introduced the concept of shear plane angle.   

 

 

2.4.1 Merchant’s Model 

 

Merchant’s analysis is based on the two- dimensional process geometry as show in 

Figure 2.9[Shaw, 1984]. An orthogonal cutting is defined by cutting velocity V, 

uncut chip thickness tu, chip thickness tc, shear angle Ø, rake angle α, and width of 

cut w. The width of cut w is measured parallel to the cutting edge and normal to 

the cutting velocity.   
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The workpiece material moves at the cutting velocity while cutting tool remains 

still. A chip is thus formed and is assumed to behave as a rigid body held in 

equilibrium by the action of the forces transmitted across the chip-tool interface 

and across the shear plane. The resultant force Fr is transmitted across the chip-tool 

interface. No force acts on the tool edge or flank. Fr can be further resolved into 

components on shear plane, rake face, on cutting direction depending upon 

research interest. Components on shear plane are Fs in the plane and Ns normal to 

shear plane. Cutting force Fp is in the cutting direction and a trust force FQ normal 

to the workpiece surface. On the rake face, the friction force Fc is in direction of 

chip flow and the normal force Nc is normal to the rake face. The relationships 

between those components and resultant force can be defined by the following 

equations: 

 

 

 

The concept of orthogonal cutting and all of the simplifying assumptions helped to 

build the fundamental cutting force analysis and left space for improvement in 

succeeding studies. Most analytical force models follow this shear plane theory or 

slip-line field theory.  
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2.4.2 Slip-line Field Theory  

 

Slip-line field solution for shear angle Ø was derived based on two assumptions:  

 The material cut behaves as an ideal plastic solid which does not strain-

hardened.  

 The shear plane represents the direction of the maximum stress.  

 

A slip-line field ABC in front of the cutting tool, shown in figure 2.10 [Waldrof, 

1996], was assumed to be plastically rigid and subjected to a uniform state of 

stress.     
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Line BC is the line along which the stress is zero. β is the friction angle on the rake 

face of the cutting. Ø is shear angle. They can be determined by:  

 

 

 

 

 

2.5   FINITE ELEMENT MODELS (FEM)  

 

 

With the development of numerical methods and advent of digital computers, 

computational difficulties and model limitations were overcome. Since 1973, the 

finite element method has been applied to simulate machining with some successes 

[Komvopoulos, 1991]. Two different finite –element formulations, the Lagrangian 

and the Eulerian, are most commonly used in the modelling of cutting process. In 

the Lagrangian approach, the finite element must consist of material elements that 

cover the region of analysis exactly. These elements are attached to the material 

and deformed with the deformation of the workpiece. In the Eulerian approach, the 

mesh 20 consists of elements that are fixed in space and cover the control volume, 

and the material properties are calculated at fixed spatial locations as the material 

flows through the mesh [Movahbedy, 2000].  

                In FEM, the material properties can be handled as functions of strain, 

strain rate and temperature. Interaction between chip and tool can be modelled as 

sticking and sliding.  Nonlinear geometric boundaries such as the free surface of 

the chip can be represented as used. Stress and temperature distribution can be 

obtained as well [Zhang, 1994; Shih, 1995]. However, large deformation of the 
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material results in the distortion of the elements and deterioration of simulation 

results. The numerical simulation of cutting process can be extremely difficult 

because of unconstrained flow of material that occurs over free boundaries. As a 

result, most of the previous analysis used simple models such as rigid-

plastic/elastic-plastic and non-hardening material behaviour, or empirical models 

depending on experimental data, ignored interfacial friction and tool wear on the 

cutting process.  

 

 

2.5.1 AdvantEdge FEM software 

 

AdvantEdge FEM is a commercial FEM software based process simulation system 

designed to analyze flow of various metal forming process. It is available in both 

Lagrangian (Transient) and arbitrary Lagrangian and the Eularian (ALE Steady-

State) modeling. Additional, the software is currently capability of Steady-State 

function and it is required of running a transient simulation previous to steady state 

cutting simulation. 

                Actually AdvantEdge FEM is a CAE software solution for the 

optimization of metal cutting. This modeling software is used by those looking to 

improve tool design, increase material removal rates, extend tool life, improve part 

quality, and much more. Use AdvantEdge FEM to decrease the need for trial and 

error testing — ultimately getting to market faster.                         AdvantEdge 

FEM is a micro-level, physics-based finite element machining modeling software 

package designed to allow a user to study the tool-workpiece interface and analyze 

the mechanical and thermal response of the tool-chip-workpiece system. 

AdvantEdge FEM provides detailed information on cutting forces, chip formation, 

temperature, heat flow, stress, strain, workpiece residual stress, etc.  

AdvantEdge simulations allow a user to reduce cutting forces, optimize cutting 

feed and speed and increase Material Removal Rates, to predict and manage 

residual stress and subsequent part distortion, to improve tool performance and 
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life.AdvantEdge FEM enables users to analyze machining processes in 2D and 3D 

environments. Manufacturers across the globe find AdvantEdge FEM to be a 

valuable resource in the design of milling, grooving, boring, sawing, broaching, 

drilling, and turning processes. 

 

How it Works: 

 

 Define tool geometry or import from CAD program 

 Select tool and workpiece materials 

 Input cutting conditions 

 Run simulations 

 Compare simulation results for different cutting conditions or tool 

geometries to find optimal results 

 Analyze temperature and stress profiles to gage reductions 

in tool wear 

 Use chip formation to predict improved chip evacuation 

 Evaluate force plots to lower cutting forces and power 

consumption 

 

 

Ongoing software benefits experienced by AdvantEdge FEM users are: 

 Increased material removal rates 

 Improved tool life 

 Predicted chip shape 

 Shortened product design cycles 

 Reduced trial and error testing 
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AdvantEdge FEM Product Specifications: 

Table 2.2: AdvantEdge FEM Product Specifications 

 

 

Troy D. Marusich, Jeffrey D. Thiele and Christopher J. Brand conducted 

SIMULATION AND ANALYSIS OF CHIP BREAKAGE IN TURNING 

PROCESSES using FE software AdvantEdge FEM. The major thrust were the 

investigation of cutting forces, chip formation and breakage, and work-hardened 

surface layer of the workpiece. Further, they also study about influence of cutting 

parameters such as cutting speed, rake angle and depth of cut. Later, the computed 

cutting force, temperature, deformations and chip geometry have been compared 

with cutting experiments. 

 

T. D. Marusich, S. Usui, J. Ma and D. A. Stephenson and A. Shih investigated 

Finite Element Modeling of Drilling Processes with Solid and Indexable Tooling in 

Metals and Stack-ups using FE software AdvantEdge FEM. Actually A three-

dimensional finite element-based model of drilling were presented which includes 

fully adaptive unstructured meshing, tight thermo-mechanical coupling, 

deformable tool-chip-workpiece contact, interfacial heat transfer across the tool-

chip boundary, and constitutive models appropriate for high strain-rate, large strain 

and high temperature deformation. 
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                 Mamalis, [mamalis, 2001] investigated FE simulation on chip formation 

in steady-state orthogonal metal cutting using finite element code MARC. The 

flow stress of the work material is taken as a function of strain, strain rate and 

temperature in order to know the effect of the large strain, strain rate and 

temperature associated in cutting process. Additional, the chip formation and the 

stress, strain and strain-rate distribution in the chip and workpiece, as well as the 

temperature fields in the workpiece, chip and tool are determined. 

 

                   Referring to iqbal and friend [Iqbal. 2006], there were effects of 

workpiece flow stress models and friction characteristics at the tool-chip interface 

by predicting on different output parameters. Further, they have been performed 

2D orthogonal cutting FE model by AdvantEdge FEM 2D simulation in order to 

predict accuracy of cutting force and shear angle. Flow stress models are used 

extensively in the simulations of deformation processes occurring at high strains, 

strain rates and temperature. 

 

                   Troy D. Marusich also studied THE EFFECTS OF FRICTION AND 

CUTTING SPEED ON CUTTING FORCE and T. D. Marusich, S. Usui, S. 

Lankalapalli, N. Saini, L. Zamorano and A. Grevstad investigated Residual Stress 

Prediction for Part Distortion Modeling using FE software AdvantEdge FEM. 

Again T. D. Marusich and E. Askari performed Modeling Residual Stress and 

Workpiece Quality in Machined Surfaces by AdvantEdge FEM software.Ageneral 

method were presented to model the residual stress state induced by metal cutting 

operations which takes into account workpiece thermo-mechanical properties, 

cutter geometry and process parameters. The model were specifically applied to 

Al7050. Results indicated the magnitude and sign of the state of stress is shown to 

have no intuitive correlation to machining process parameters such as speed and 

chip load.  Similar results were shown for stress-induced bending moments, a 

potential strong contributor to part distortion.  In addition, the machining-affected 

layer were shown to be on the order of 1mm, easily on the same length scale as the 

wall thickness of aerospace structures. 
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2.6   Conclusion 

 

According Merchant’s shear plane analysis, the concept of friction implies that 

friction force and normal force are uniformly distributed over the sliding interface. 

However, this is not the case of metal cutting and this approach provides 

coefficient of friction is too simple. Additionally, the friction formula is relevant 

only to sliding conditions that was probably bring weakness of this analysis.  

Continuous to Lee and Shaffer with their slip line theory, the most likely sources of 

the poor agreement are the material assumption, that is work material is rigid-

perfectly plastic and the simple friction assumption. As a result, a more recent 

approach in the studies of metal cutting has been employed. FEM has employed to 

conduct simulation of cutting processes. The FEM is more accurate due to ability 

to incorporate more realistic assumptions of material behavior and the influence of 

friction. 
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Chapter 3 

METHODOLOGY: 

 

 

3.1 Introduction 

 

 

The software AdvantEdge FEM is used in this study to simulate the two and 

three-dimensional orthogonal metal cutting process. The finite element model is 

composed of a deformable workpiece and a rigid tool. Overall, there have been a 

series of cutting test that will be carried out for simulation in varies machining 

parameters of cutting speed, feed rate and depth of cut.  

 

The relationship exist between cutting performance such as cutting forces, residual 

stresses, cutting temperature and cutting condition may be established theoretically 

by Finite Element Methods (FEM) analysis model. The proposed workfocuses on 

the development model of Finite Element Analysis (FEA) procedures to achieve 

the research objectives as mentioned in section 1.4. Flow chart in Figure 3.1 

indicates the flow of this simulation. 
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                              Figure 3.1:  process flow chart for simulation 
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3.2   Finite element Systems 

 

In order to improve metal cutting processes, i.e. lower part cost, it is necessary to 

model metal cutting processes at a system level (Ehmann  et. a., 1997).  A 

necessary requirement of such is the ability to model interactions at the tool-chip 

interface and thus, predict cutter performance.  Many approaches such as 

empirical, mechanistic, analytical and numerical have been proposed.  Some level 

of testing for model development, either material, machining, or both is required 

for all.  However, the ability to model cutting tool performance with a minimum 

amount of testing is of great value, reducing costly process and tooling iterations.  

In this paper, a validated finite element-based machining model is presented and 

employed to calculate chip geometry, chip breakage, cutting forces, and effects in 

work-hardened workpiece surface layers.  

Typical approaches for numerical modeling of metal cutting are Lagrangian and 

Eulerian techniques. Lagrangian techniques, the tracking of discrete material 

points, have been applied to metal cutting (Strenkowski and Carroll, 1985; 

Komvopoulos and Erpenbeck, 1991; Sehkon and Chenot, 1993; Obikawa and 

Usui, 1996; and Obikawa et.al 1997.).  Techniques typically used a predetermined 

line of separation at the tool tip, propagating a fictitious crack ahead the tool. This 

method precludes the resolution of the cutting edge radius and accurate resolution 

of the secondary shear zone due to severe mesh distortion. To alleviate element 

distortions, others used adaptive remeshingtechniques to resolve the cutting edge 

radius (Sehkonand Chenot, 1993; and Marusichand Ortiz, 1995).  Eulerian 

approaches, tracking volumes rather than material particles, did not have the 

burden of remeshing distorted meshes (Strenkowski and Athavale, 1997). 

However, steady state free-surface tracking algorithms were necessary and relied 

on assumptions such as uniform chip thickness, not allowing the modeling of 

milling processes or segmented chip formation. 

The right choice of finite element software is very important in determining the 

scope and quality of the analysis that will be performed. The most important 

software codes used for simulation ofmetal cutting are: Abaqus, Deform and 

AdvantEdge FEM. Applications of FEM models for machining can be divided in 

six groups: tool edge design, tool wear, tool coating, chip flow, burr formation plus 

residual stress and surface integrity. 

In this paper, a Lagrangian finite element-based machining model is applied in 

304-stainless-steel to predictthe effect of cutting speed and feed rate on the cutting 
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forces and chip breakage in turning process.chip. First, the orthogonal cutting 

model is validated against cutting forces and chip thickness. Second, a chip 

breakage criterion is implemented and validated against a range of cutting 

conditions and cutter geometries. Techniques such as adaptive remeshing, explicit 

dynamics and tightly coupled transient thermal analysis are integrated to model the 

complex interactions of the cutting tool and workpiece. 

 

3.3 Machining Simulation System 

 

Simulations were performed with Third Wave Systems AdvantEdge machining 

simulation software, which integrates advanced finite element numerics and 

material modeling appropriate for machining.  The orthogonal cutting system is 

described in Fig. 3.2 where the observer is in the frame of reference of the cutting 

tool with the workpiece moving with velocity v.  The cutting tool is parameterized 

by rake and clearance angles, and a cutting edge radius, but can also accommodate 

general chip breaker geometries.  In the plane strain case the depth of cut into the 

plane is considered to be large in comparison to the feed.  The cutting tool initially 

indents the workpiece, Fig. 3.3, the chip begins to form Fig. 3.4, and finally curls 

over hitting the workpiece ahead of the cut, Fig. 3.5. 

 

 

                    Figure 3.2 Schematic of orthogonal cutting conditions. 
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                  Figure 3.3 Initial tool indentation 

 
                      Figure 3.4 Chip formation 
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         Figure 3.5Fully developed continuous chip 

 

3.4 Modeling Approach 

 

Third Wave AdvantEdge is an explicit dynamic, thermo-mechanically coupled 

finite element modeling package specialized for metal cutting.  Features necessary 

to model metal cutting accurately include adaptive remeshing capabilities for 

resolution of multiple length scales such as cutting edge radius, secondary shear 

zone and chip load; multiple body deformable contact for tool-workpiece 

interaction, and transient thermal analysis.A major thrust of this paper is the 

investigation of cutting forces, chip formation and breakage, and work-hardened 

surface layer of the workpiece.  In order to resolve the critical length scales 

necessary in the secondary shear zone and the inherent large deformations while 

maintaining computationally accurate finite element configurations, adaptive 

remeshing techniques are critical.  Near the cutting edge radius, the 

workpiecematerial is allowed to flow around the edge radius.  The initial mesh, 

Fig.3.6, becomes distorted after a certain length of cut, Fig.3.7, and is remeshed in 

this vicinity to form a regular mesh again, Fig.3.8.  For a comprehensive discussion 

on the numerical techniques the reader is referred to Marusich and Ortiz (1995). 
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         Figure3.6: Initial mesh magnified in the cutting tool edge vicinity. 

    
                                        Figure 3.7: Deformed mesh 
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                            Figure 3.8: Updated mesh 

 

3.5 Constitutive Model and Material Characterization 

 

In order to model chip formation, constitutive modeling for metal cutting requires 

determination of material properties at high strain rates, large strains, and short 

heating times and is quintessential for prediction of segmented chips due to shear-

localization  (Sandstrom and Hodowany 1998; Childs, 1998 ). The reader is again 

referred to Marusich and Ortiz (1995) for specific details of the constitutive model 

adopted.  The model contains deformation hardening, thermal softening and rate 

sensitivity tightly coupled with a transient heat conduction analysis appropriate for 

finite deformations. 
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3.6 Modeling using AdvantEdge FEM 

 

Nowadays, the finite element analysis is the main tool regarding the metal cutting 

process modelling and simulation. It has important advantages, such as: the 

prediction of cutting forces and chip shape; it solves contact problems between 

bodies; it uses bodies made from different materials, etc.It is a well known fact that 

machining, especially orthogonal cutting is a common process in industry. 

Creating accurate models using the finite element method results in optimizing 

these processes, thereby a reduction of the experiments number results, implicitly 

of the time and costs related to these operations. 

AdvantEdge FEM is an explicit commercial code for designing, improving and 

optimizing machining processes. The solver is optimized for metal cutting 

processes. Some advantages of using this software are [17]: it reduces cutting tests, 

extends tool life and reduces tool breakage, uses complex geometries of tools and 

workpieces, faster machining processes, efficient productivity, increases material 

removal rates and machine utilization, etc. This software has a high level of details 

and a simple and user friendly interface which allows users to easily set the 

modelling and simulation data. It is capable to model complex interactions 

between tool and workpiece, and covers a wide range of cutting types from turning 

to milling. 

Before modeling and simulation, the user should set the initial data, namely 

process parameters and conditions: cutting speed, depth of cut, feed rate, 

environment temperature, whether a coolant will be present or not and friction 

coefficient. 

 

 

 

3.6.1 Pre-processor module 

 

The Simulation Setup Interface allows users to setup the entire simulation, defining 

tool geometries, material conditions and machining parameters. 
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It contains:  

 a user friendly interface  

 an extensive standard tools library  

 an extensive material library  

 offers the possibility of creating new tool and workpiece geometries within 

the program and also to import complex geometries form other CAD files  

 offers the possibility of introducing new materials 

 

 

3.6.2Simulation module 

 

The AdvantEdge Engine performs all the hidden calculations.  

Simulations can run in:  

 Demonstration mode, decreases the simulation time but is less accurate  

 Standard mode, requires longer simulation time but is more accurate 

 

 

3.6.3Post-processor module 

 

The Tecplot displays and assists in analyzing the simulation results.Among the 

displayed results there can be enumerated: chip formation, chip and tool 

temperature, cutting forces, steady state variables such as: strain, stress, strain von 

Misses, etc. 
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3.7 Simulation 

 

Simulation are abstractions of reality.Often they deliberately emphasize one part of 

reality at the expense of other parts.Sometimes this necessary due to computer 

power limitations.Sometimes it’s done to focus your attention on an important 

aspect of the simulation.Whereas model are mathematical,logical,or some other 

structured representation of reality,simulations are the specific application of 

models to arrive at some outcome. 

 

 

3.7.1Three types of simulations 

 

Simulations generally come in three styles:live,virtual and constructive.A 

simulation also may be a combination of two or more styles.Within these styles, 

simulation can be science-based(where,for example,interactions of things are 

observed or measured),or involve interactions with humans.Our primary focus at 

IST is on the later –human-in-the-loop-simulations. 

Live simulations typically involve human’s and\or equipment and activity in a 

setting where they would operate for real.Think war games with soldiers out in the 

field or manning command posts.Time is continuous,as in the real world.Another 

example of live simulation is testing a car battery using an electrical tester. 

Virtual simulations typically involve humans and\or equipment in a computer –

controlled setting.Time is in discrete steps,allowing users to concentrate on the 

important stuff,so to speak.A flight simulator falls into this category. 

Constructive simulations typically do not involve humans or equipment as 

participants.Rather than by time,they are driven by the proper sequencing of 

events.The anticipated path of a hurricane might be “ constructed “ through 
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application of temperature,pressures,wind currents and other weather 

factors.Science-based simulations are typically constructive in nature. 

 

 

3.7.2 Why simulation is important 

 

 

Simulation provides a method for checking your understanding of the world 

around you and helps you produce better results faster.A simulation program like 

ExtendSim is an important toll that you can use to: 

 Understand why observed events occur. 

 Identify problem areas before implementation. 

 Explore the effects of modifications. 

 Confirm that all variables are known. 

 Evaluate ideas and identify inefficiencies. 

 Gain insight and stimulate creative thinking. 

 Communicate the integrity and feasibility of your plans. 

 

 

 

3.8 Simulation work 

 

Simulations were performed with Third Wave Systems AdvantEdge finite element 

based modeling software known as AdvantEdge FEM, which integrates advanced 

finite element numerics and material modeling for customize for machining 

applications. 
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3.8.1 Simulation using AdvantEdge FEM software  

 

Third Wave systems AdvantEdge is the software leader in providing solutions for 

optimizing traditional and state-of-the-art machining processes.AdvantEdge suite 

of software allows aerospace,automotive and cutting tool companies-along with 

their suppliers- to reduce the cost of machine components and get to market 

sooner. 

Machining simulations provide more information, in a timely manner,and at a 

lower cost than traditional trial and error testing-leading to better 

decisions.Whether your cost driver is reducing  cycle,improving part 

quality,improving tool life,improving tool design ,or completely process set up and 

improvement ,Third wave systems can help you gain the AdvantEdge. 

 

3.8.1(A) Strategy 

 

 Complete basic steps of setting up and submitting a new job.  

 Learn to import a custom workpiece and tool.  

 Learn how to analyze results using Tecplot 

 

 

3.8.1(B) Project Setup  

 

 Open AdvantEdge FEM by selecting Start ► Programs ► 

ThirdWaveSystemsAdvantEdge ► AdvantEdge 

 Click Project ► New  

 Enter Example for the project name  

 Select Turning for project type  
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 Check 2D Simulation and click OK 

 

 

                                         Figure 3.9: Project setup 

 

3.8.1(C) Workpiece geometry 

 

 Select Workpiece ► Create/Edit Standard Workpiece 

 Enter a workpiece height of 1 and a workpiece length of 3(enter height and 

length according to the necessary ,here only example is given), and click OK  

 Select Workpiece ► Material…  

 From the Workpiece Material pulldown menu, select stainless steel  

 Select the 304-stainless-steel material, and click OK  
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Note: the use of the Properties button for additional material information; the 

material hardness can be modified by selecting the User Define option in this 

window.   

 

                                          Figure 3.10: Turning worpiece setup 

 

Figure 3.11: Workpiece material selection 
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3.8.1(D) Tool  geometry 

 

 Click Tool ► Import Tool ► Tools…  

 Select turning tool parameters  and click OK  

 Select Tool ► ToolMaterial…  

 Select the Carbide–Grade-K material, and click OK 

 

 

 

Figure 3.12: Turning tool parameters setup 
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Figure 3.13: Tool material selection 

 

 

3.8.1(E) Process Parameters 

 

 Select Process ► Process Parameters… 

 Within the Turning Process Parameters window, enter the process 

parameters shown below, and then click OK 
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Figure 3.14: Turning process parameters setup 

 

 

3.8.1(F) Simulation Output Customization 

 

 Select Simulation ► Simulation Options and access the General Tab  

 Select Rapid for the simulation mode  

 

Note: Rapid mode is being used in this example to find a fast result for 

demonstration purposes.  Generally, standard mode is recommended as it utilizes a 

more refined mesh to provide more reliable and accurate results. 
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3.8.1(G) Submitting the Project 

 

 Select Project ► Save As   

 Name the project example.twp, and click Save  

 Select Simulation ► Submit ► Submit Current Job, and then click OK 

 

                                

 

 

Figure 3.15: Submission of the project in the software 
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Figure 3.16: Submission of the project in the software in detail view 

 

3.8.1(H) Viewing the Results 

 

 Select Simulation ► Results  

 Tecplot will now open and you will be able to view the results of the 

simulation thus far.    
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Note: In order to see the most recent results, Tecplot must be closed and then re-

opened.  This will update the results to the point at which the simulation has 

currently run. 

 

                            

Figure 3.17: Viewing the result in the software  

 

3.8.1(I) Using Tecplot 

Zooming and Panning  

 Click and hold the middle mouse button and zoom in and out by moving the 

mouse up and down.  

 Pan around the results by clicking and dragging with the right mouse button.    

 

Probing for Data  

 Click the Tool to Probe Data button from the group of icons on the left side 

of Tecplot. 

 Using the Probe tool, click on the simulation results to see information about 

that specific point. 
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Figure 3.18: Use of Tecplot in the software   

 

 

Quick Analysis Dialog 

 

 Select Tools ► AdvantEdge Quick Analysis  

 Explore the different functions available in each of the different tabs.  

Contour relates to the top half of the results, and Time History relates to the 

bottom half. 
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Figure 3.19: Quick Analysis Dialog 

 

3.8.1(J) Deleting the Project 

 

Before moving on, it is necessary to stop the job that is currently running (if it has 

not finished yet).  

 Select Job ► Delete. The analysis will be stopped and removed from the 

AdvantEdge Job Monitor list.  
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Figure 3.20: Deleting the Project 

 

 

3.9 Conclusion 

 

AdvantEdge FEM use to decrease the need for trial and error testing.The structure 

of the AdvantEdge FEMcan be obtained with the help of pre-processor module, 

simulation module and postprocessor module, Table 1. The pre-processor module 

isdeparture support. It contains data input for the models and also the simulation 

controls. The simulation module is the module where the actual simulation takes 

place. Once the necessary data for the modelling and simulation have been 

entered, the solver makes calculations using the finite element method. These 

computations are hidden from user. After the calculations are made, in the 
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postprocessor module, the results are processed and displayed in various forms, 

such as graphs and images. Among the results obtained, we can enumerate: chip 

formation, chip and tool temperature, stresses, strains, cutting forces, tool wear, 

damage etc.Actually AdvantEdge FEM contains:  

 An extensive standard tools library, but also gives user the possibility of 

creating, within the program, new tool geometries and also importing them 

from CAD files;  

 An extensive material library, but also gives to the user the possibility of 

introducing new materials, based on known material properties. 
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Chapter 4 

RESULT: 

 

4.1 Introduction 

 

Simulations were performed with Third Wave Systems AdvantEdge finite 

element based modeling software, which integrates advanced finite element 

numerics and material modeling for customize for machining applications. And 

the experimental work of our study has been done in the machine lab of Islamic 

University of Technology. The main aim of our study is to Study and determine 

the influence of process parameters (feed rate, cutting speed, rake angle, depth 

of cut and length of cut) upon cutting force, temperature and chip breakage. 

And Compare between simulation and experimental results to indicate the 

results are consistent or inconsistent. 

 

 

4.2 Experimental design 

 

We have done five experiments to study the effect of cutting speed and feed 

rate on the cutting forces and chip breakage in turning process. Actually we do 

simulation work with the help of AdvantEdge FEM software and experimental 

work in the machine lab with the help of turning machine. The experimental 

design of our study is given bellow with the help of a table. 
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Table 4.1: Experimental design 

Experiment 

No  

Parameter Values  

Cutting Speed 

(m/min)  

Rake Angle 

(
0
)  

DOC 

(mm)  

Feed 

(mm/rev) 

01  23  -5  2 0.15 

02  47  -5 2 0.15 

03  70  -5 2 0.15 

04 40  -5 1 0.20 

05  68  -5 1 0.20 

 

 

4.3 AdvantEdge and Experiment result 

 

AdvantEdge FEM uses the continuous remeshing in order to separate the chip. 

During metal, cutting the workpiece material flows around the cutting edge of the 

tool and the remeshing takes place whenever the elements from the cutting edge 

area change their initial shape. Due to automatic remeshing, these programs allow 

also the modelling and simulation of complex geometry workpieces. we get the 

simulation result with the help of AdvantEdge FEM software. And the 

experimental result from the machine lab by doing work by with the help of 

turning machine. 

 



Page | 69 
 

 

4.3.1 Simulation Result  

 

Before starting the simulation, the user must know that in AdvantEdge FEM 2D 

the material behaviour law can be also introduced. The Johnson-Cook material 

behaviour model is widely used in finite element modelling but in this case it 

cannot predict the phenomena responsible for the appearance of the segmented 

chips, also known as saw-tooth chips. Calamaz et al.developed a new material law 

which considers the strain rate, the temperature and also the strain softening effect 

when analyzing the chip formation and shear localization during machining. 

The simulation result that we have got from the AdvantEdge FEM software 

directly for different experiments are given bellow with the help figure. 

 

             

Figure4.1:Result of simulation for experiment 01 using AdvantEdge FEM software 
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Figure4.2:Result of simulation for experiment 02 using AdvantEdge FEM software 

              

Figure4.3:Result of simulation for experiment 03 using AdvantEdge FEM software 
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Figure4.4:Result of simulation for experiment 04 using AdvantEdge FEM software 

              

Figure4.5:Result of simulation for experiment 05 using AdvantEdge FEM software 
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4.3.2 Result Analysis of Cutting Force and 

Temperature with respect to Time 

 

For Experiment 01, 02, 03 (where cutting speed is 23, 47, 70m/min respectively 

and feed rate is same for this three experiments which is 0.15mm). Actually for 

experiment 03 we take the highest cutting speed as 70m/min. And for this reason 

experiment 03 takes short time to complete the simulation than the experiment 01 

& 02. The following figure shows the effect of cutting speed. 

 

 

Figure4.6: Result Analysis of Cutting Force and Temperature with respect to Time 

using AdvantEdge FEM software for experiment 01, 02 & 03 
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Again for Experiment 04, 05 (where cutting speed is 40,68m/min respectively and 

feed rate is same for this two experiments which is 0.20mm). Actually for 

experiment 05 we take the highest cutting speed as 68m/min. And for this reason 

experiment 05 takes short time to complete the simulation than the experiment 04. 

The following figure shows the effect of cutting speed. 

 

 

 

Figure4.7: Result Analysis of Cutting Force and Temperature with respect to Time 

using AdvantEdge FEM software for experiment 04 & 05 
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4.3.3 Measurement of Chip Thickness from 

Simulation 

 

Actually from the AdvantEdge FEM software we can measure the thickness of the 

chip by using measurement bar of the software. The following figure shows the 

way how we measure the thickness of the chip using AdvantEdge FEM software. 

 

 

 

 

Figure4.8: Measurement of Chip Thickness from Simulation using AdvantEdge 

FEM software for experiment 02 (where cutting speed is 47m/min and feed rate is 

0.15mm) 
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Figure4.9: Measurement of Chip Thickness from Simulation using AdvantEdge 

FEM software for experiment 05 (where cutting speed is 68m/min and feed rate is 

0.20mm) 

 

The above figure shows the example of the measurement of the thickness of the 

chip using AdvantEdge FEM software. We have done the same thing that is shown 

in the above figure to measure the thickness of the chip for experiment 01, 03 & 

04. The results we get from the simulation are: 

 For Experiment no 01, thickness of the chip is  0.34mm 

 For Experiment no 02, thickness of the chip is  0.34mm 

 For Experiment no 03, thickness of the chip is  0.35mm 

 For Experiment no 04, thickness of the chip is  0.45mm 

 For Experiment no 05, thickness of the chip is  0.44mm 
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4.3.4 Measurement of Chip Thickness from 

Experiment 

 

Kobayashi et.al.(1960)  observed  continuous  chip morphologies for the conditions 

investigated. We measure thickness of the chip with the help of slide caliper in the 

machine lab.The figures of chip that we found from the experiment are given 

bellow: 

                     

                      Figure4.10: Chip that we found from the experiment 01 

                      

                       Figure4.11: Chip that we found from the experiment 02 
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                        Figure4.12: Chip that we found from the experiment 03 

                     

                         Figure4.13: Chip that we found from the experiment 04 

                     

                    Figure4.14: Chip that we found from the experiment 05 
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Now the results we get from the experiment are: 

 For Experiment no 01, thickness of the chip is  0.30mm 

 For Experiment no 02, thickness of the chip is  0.35mm 

 For Experiment no 03, thickness of the chip is  0.28mm 

 For Experiment no 04, thickness of the chip is  0.55mm 

 For Experiment no 05, thickness of the chip is  0.45mm 

 

4.3.5 Chip thickness comparison 

 

Chip thickness provides an estimation of friction conditions. The simulated and 

experimented chip thicknesses are compared for 304-stainless-steel in Fig.4.11.  

 

              

 

                               Figure4.15: Chip thickness comparison 
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As we see, there is a small difference between the simulation and experimental 

result of chip thickness. The reasons behind this variation are as follows:  

 Machine used for the experiment was not up to date. 

  Errors may be occurred when process parameter was set up manually. 

 Thickness of the chips being very small, errors may be occurred in 

measurement of thickness with slide calipers. 
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Chapter 5 

DISCUSSION AND CONCLUSION: 

 

5.1 Introduction 

 

In this paper, an attempt has been made to study the effect of cutting speed and 

feed rate on the cutting forces and chip breakage in turning process. Metal 

cutting modeling provides an alternative way for better understanding of 

machining processes under different cutting conditions. Using the capabilities 

of finite element models, it has recently become possible to deal with 

complicated conditions in metal cutting. Finite element modeling makes it 

possible to model several factors that are present during the chip formation .As 

simulation tool for the purpose of this study; the FEM software used is 

AdvantEdge FEM.Actually this paper presents the advantage of using software 

for simulation of cutting process and study of stainless steel turning. To 

complete our research wok we use 2D Finite Element Model (F.E.M.) of chip 

formation process, proposed in the software named AdvantEdge FEM with an 

experimental set up in the laboratory.  

 

5.1 Discussion 

 

Based on the review, the following things have been observed:  

 Increased cutting speeds (VC) resulted in decreased cutting tool forces and 

machined surface temperatures. 

 Tool wear resulted in increased cutting tool forces and machined surface 

temperature. 

 Force has been found to be an important variable in the generation of 

surface temperature. 
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 Thus, it is possible to increase machine utilization and decrease production 

cost in an automated Manufacturing environment. 

 Increasing the rake angle in positive section caused the decrease of the 

cutting force. On the other hand, increasing the rake angle in negative 

section increases the cutting force.  

 The AdvantEdge FEM software used for this study has some features. They 

are given bellow with the help of a table: 

Table5.1: Features of AdvantEdge FEM software 

                       

 The AdvantEdge FEM software has some advantages. They are given 

bellow with the help of a table: 

 

Table5.2: Advantages of AdvantEdge FEM software 

 

Advantages of AdvantEdge FEM software  

Simple, 
User 

friendly 
interface 

The solver 
is optimised 

for metal 
cutting 

processes  

Offers the 
possibility of 
creating new 
geometries 
and also of 
importing 

them  

Extensive 
material 

library and 
also 

possibility 
of creating 

new  

The 
solver 

runs fast 



Page | 82 
 

5.3 Conclusion: 

 

A finite element model was utilized to study the effect of cutting speed and feed 

rate on the cutting forces and chip breakage in turning process in 304-stainless 

steel. The AdvantEdge FEM software used for this study because, AdvantEdge 

FEM decrease the need for trial and error testing. The simulation results on cutting 

forces and chip thicknesses are compared with experimental data in order to 

indicate the consistency and accuracy of the results when conducting the 

comparison. The experimental validation showed a good qualitative agreement. 

Thus, FEM of cutting process can be considered as a promising and reliable tool 

for machining development within the near future. 

 

 

5.4 Future Scope  

 

Turning Process is a important machining process in which a single-point cutting 

tool and cutting inserts removes material from the surface of a rotating cylindrical 

work piece, so by the finite element analysis on turning process helps to determine 

problems were occur in tool and  workpiece like plastic deformation, mechanical 

breakage, cutting edge blunting,  brittle fracture and tool wear can reduce and by 

the considering optimized parameter. We can find minimum surface roughness and 

high surface finish. Also we can increases tool life. 
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